TL1000
User’s Manual

GPS Distance and Route Recorder
# Contents

- **Introduction** ................................................................................................................................. 3
- **Getting Started** ............................................................................................................................... 3
  - **Box Contents** ................................................................................................................................. 3
  - **Installing the TripLogik Logger in your Car** ............................................................................... 4
  - **Installing TripLogik Manager Software** ...................................................................................... 5
- **Logging Trips** ................................................................................................................................. 6
  - **Before driving away** ..................................................................................................................... 6
  - **Driving** .......................................................................................................................................... 6
  - **Auto-Categorise a Trip** .............................................................................................................. 6
  - **Recording Points of Interest** ...................................................................................................... 6
  - **Visual and Audible indicators** .................................................................................................... 6
  - **Connecting and disconnecting the logger** .................................................................................. 6
- **TripLogik Manager** ......................................................................................................................... 7
  - **First Look** .................................................................................................................................... 7
  - **Managing your Logger** ............................................................................................................... 7
  - **Working with Places** .................................................................................................................. 8
  - **Working with Trips** .................................................................................................................... 8
  - **Categorising Places and Trips** .................................................................................................. 9
  - **Saving your Data** .......................................................................................................................... 9
  - **Working with Reports** .............................................................................................................. 10
  - **Advanced Features** .................................................................................................................. 11
  - **Reference** .................................................................................................................................... 12
- **Specification** .................................................................................................................................. 14
- **Acknowledged Trademarks** ......................................................................................................... 14
- **1 Year Limited Warranty** ............................................................................................................. 15
- **Compliance Statements** ............................................................................................................... 16
Introduction

Thank you for purchasing the TripLogik Distance and Route Recorder, we hope you get many years of use from this innovative product.

Once you have installed the TripLogik Distance and Route Recorder while it is connected it will log every journey that your vehicle makes whether it is simply a short trip to local shops, visits to your customers or a weeks fishing and hunting vacation.

Your Route Recorder (logger) has sufficient capacity to store information on journeys equivalent to driving 4 hours/day for the whole year before it becomes full.

Please take the time to read this manual to get the most out of your new purchase.

Please Read first
The Route Recorder is not dust-proofed, drip-proofed or waterproofed.

Do not expose to temperatures above 65°C (149°F).

It is recommended you only use with the power adapters supplied. The Route Recorder requires 5V dc at 80mA max, 50mA average.

The Route Recorder incorporates a sensitive radio receiver. Do not operate close to strong radio waves or radiation.

When disconnecting the USB lead pull it by the plug not the cable.

Disposal of Old Electronic Equipment

Do not dispose of this item in household waste. Recycle or dispose of separately.

Getting Started

Box Contents

Ensure that you have the following items supplied with your TripLogik Logger.

TripLogik Route Recorder

USB to Mini-USB connecting Cable

ODBii Power Adapter and Cable

Cigarette Lighter Power Adapter

CD-ROM containing:
- TripLogik Manager Application
- User Manual

Quick Start Guide
Hook and loop pads
1 alcohol wipe
**Installing the TripLogik Logger in your Car**

**Positioning**
Place the TripLogik Logger on the dashboard in as horizontal a position as possible. Generally the best places are centrally or to the left or right hand end of the dashboard. Try to position it so that the top of the unit has a clear line of sight vertically through the windscreen.

On some vehicles where the windscreen has only a slight rake you may need to place the unit up close to the windscreen to get the best line of sight to the sky.

Use the self adhesive hook and loop pads provided to retain the unit in place. To ensure the optimum adhesion first clean the surface of the dashboard with the alcohol wipe provided.

**Connecting the Power**
There are 2 options for powering the Logger.

**Preferred Method**
The preferred method for powering the unit is from your vehicle’s on board diagnostic connector (ODBii) using the power adapter cable provided. The ODBii connector is normally situated beneath the dash on the driver’s side of the car.

*Note* – ODBii connectors are standard on all cars produced after 1996.

In most vehicles the ODBii connector remains powered even when the vehicle’s ignition is turned off which means your logger will be ready to log as soon as you get in your vehicle.

It also leaves your cigarette lighter socket free for other uses.

Locate the connector (there may be a small cover over it) and connect in the power adapter cable supplied. Plug the other end of the cable into the TripLogik Mileage Logger.

**Important!**
Coil up any excess cable and secure it in a position where it will not be a hazard when driving.

**Alternative Method**
If your vehicle is not equipped with an ODBii diagnostic port or you prefer not to use the diagnostic port a cigarette lighter adapter is provided.

Plug the adapter into a suitable cigarette lighter socket and use the USB to Mini-USB cable to connect to the TripLogik Logger.

Power to the Logger might not be available until you switch the vehicle’s ignition on.

*Note* – While in many vehicles the ODBii connector remains powered at all times some remove power from the connector when the car is locked.

On most vehicles the cigarette lighter is only powered on when the vehicle’s ignition is turned on.

In either of the above situations if power has been removed from the logger for more than a couple of hours the logger will perform a cold start which can take 36 Seconds or longer.

**Checking Operation**
On receiving power the elliptical button on the Logger will start flashing indicating the unit is searching for satellites.
If the vehicle is positioned in an open area, after about 36 seconds the indicator should cease flashing and remain permanently on and the logger will issue a short bleep. This indicates the unit is receiving sufficient position data from the satellites to produce a fix.

After 1 minute, if there has been no movement the unit will revert to standby and the indicator will extinguish.

Following any movement the logger will awake from standby and the indicator illuminate.

**Note** – If you require the data stored in your logger to be secure it is recommended that you change the password prior to use.

You can change the password using the TripLogik Manager software.

Be aware that any changes to the password will cause all previous collected data to be deleted.

**Installing TripLogik Manager Software**

**Minimum PC Requirements**

Please note the minimum requirements for running the software are:

- PC running Microsoft™ Windows XP (or above).
- 1 USB Port, mouse and keyboard and CD Drive.
- 25Mbyte free disk space
- An Internet connection

**Running Setup**

Place the CD enclosed in your PC's CD drive, Setup will run automatically. Read the terms and conditions and accept them then follow the instructions on the screen.

Once set up has completed you can start TripLogik Manager at any time by clicking on the desktop Icon or from the Programs menu.

**And finally…**

If you are likely to use the TripLogik Manager with more than one Logger it is advisable to add an ID mark to each Logger.

Use the white space provided on the rear label of the unit to add a mark identifying the owner or user of the Route Recorder

---

**Your TripLogik Route Recorder should now be set up and ready to Use.**
Logging Trips

This section explains how to use the TripLogik Mileage Logger in your vehicle.

Before driving away

Before driving away check that the TripLogik indicator is continuously illuminated and not flashing. While it is flashing your logger will not be ready and will be unable to log your vehicle’s movements.

- In most vehicles, if your logger is connected to the ODBii connector it should be ready to log your journey as soon as you start your vehicle.

- If your logger is connected to a cigarette lighter, the logger will not power up until you turn on the vehicle ignition and could take 36 Seconds or more before it is ready.

Note – If the logger detects vehicle movement before a satellite fix has been acquired it will issue a warning with 3 bleeps on the audio sounder.

Driving

Once TripLogik Logger has acquired the satellite signals you are ready to go. The Logger will record all your vehicles movements in its on board memory without further intervention.

Auto-Categorise a Trip

This feature can be set up from TripLogik Manager and allows you to assign a category to your trip when driving. The defaults are Business and Personal.

When you first drive away the logger will issue a two tone beep as a prompt. To assign it as a Business trip press the button any time during the trip. It will issue a single bleep in acknowledgement. If you do not press it the trip will be assigned as Personal.

Recording Points of Interest

If you want to record a specific location en-route press and hold the button on the Logger for greater than 2 seconds until you hear 3 bleeps (2 short and 1 long). The logger will also flash the indicator at which point the co-ordinates of that location will be recoded.

Later when you upload your logs to your PC you can retrieve the location of points of interest and view them in Google Maps™ using the TripLogik Manager.

Visual and Audible indicators

The Logger reports its status through a combination of the indicator under the elliptical button and an internal sounder.

<table>
<thead>
<tr>
<th>Visible</th>
<th>Audible</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Single</td>
<td>Fix acquired</td>
</tr>
<tr>
<td>Flashing</td>
<td>Multiple</td>
<td>Acquiring Fix</td>
</tr>
<tr>
<td>Flashing</td>
<td>Multiple</td>
<td>Acquiring Fix while moving</td>
</tr>
<tr>
<td>Rapid</td>
<td>Single</td>
<td>Lost power</td>
</tr>
<tr>
<td>Flash</td>
<td>Two Tone</td>
<td>Memory is running low</td>
</tr>
</tbody>
</table>

Connecting and disconnecting the logger

If you have installed the ODBii adapter to connect or disconnect the logger simply plug or unplug the mini-USB connector.

If you are using the cigarette lighter connector unplug the USB cable at the power adaptor end. (You will need the cable to connect the logger to your PC).

Caution – When removing the USB Cable pull the plug, not the cable. When inserting the USB connector make sure it is correctly orientated. Do not attempt to force the plug or you risk damaging your logger.
TripLogik Manager

When you have accumulated a few trips you can upload these to your PC.

Remove the Logger from your vehicle. Using the USB cable supplied, connect it to a USB port on your PC, the button on the Logger will illuminate.

If the PC does not detect the logger, disconnect, hold down the button on the logger and reconnect.

First Look

Run TripLogik Manager. The screen will open with a map to the right and a blank column to the left.

Click on the Sync Toolbar button. Your logs will be imported and, if you are connected to the Internet, TripLogik Manager will look up the places you have visited on Google Maps™.

A brief address for each place visited will appear in the left hand column and the first item will be shown on the map. Beneath the list is an aerial view (Super Zoom) of the first place in the list.

Click on Trips to view each journey the logger has identified. In Trips you can merge, demerge, delete, name and categorise your journeys.

Click on Reports to generate filtered reports which can be viewed, printed or exported to other applications.

You can save your trips in a Trip File on your PC by choosing File, Save. Similarly, you can open an existing Trip File by choosing File, Open.

The following sections cover these and other activities in more detail. Further information can be found in the on-line help. Press the F1 key at any time or choose Help Topics from the Help Menu.

Managing your Logger

Using Passwords

The Logger is password protected. Its default password is the Logger’s serial number. You can access this number by selecting Tools, TripLogik Status…

To change the password, from the menu select Logger, Change Password…

Warning - All your data will be erased if you change the password.

Enter the new password, confirm it and choose OK. The application will register this password against the serial number of the logger.

If you attempt to access a logger whose password has not been registered by the TripLogik Manager on that PC, the application will ask for the password.

Unless you have chosen not to, correct entry will register the Logger password and you will not have to enter the password again on that PC.

Synchronising your data

When you connect the Logger to a USB port while TripLogik Manager is running you will be able to upload the latest trip data into the Manager.

You can initiate an upload either by clicking on the Sync button on the toolbar or choosing Sync from the Logger Menu.

If you already have a trip file open the Manager will only import trips which are more recent than those held in the current Trip File.
If you have no trip file open the Manager will import all the trips.

**Working with Places**

The Places tab shows a list of all the places you have visited. By default each place will have a descriptive name, typically the street name and town supplied by Google Maps™. If it could not be identified its name will be ‘Unknown’.

Each place also shows a percentage value indicating the number of times that location has been visited as a proportion of the total number of trips. Typically, your Home or Office locations would have a high percentage of visits.

**Adding Information to a Place**

Along the top of the Map window are 3 fields Description, Category and Qualifier which you can use to add more meaningful information to the Place.

Use Description to give the place a description which is meaningful to you e.g. Home, Main Office, London Office etc. Each time you visit that place, it will be associated with the description you have given it.

You can also assign a Category and a Qualifier attribute to each place. E.g. your main office could have the Category of Business and a Qualifier of Head Office. (See Categorising Places and Trips for further information.)

The Description and the Category and Qualifier attributes will be saved when you save your database.

It is recommended that you provide a name for regularly visited places as it will enable TripLogik Manager to quickly identify all these locations both now and in future uploads.

**Working with Trips**

The Trips tab shows a list of all the journeys the logger has recognised as trips.

During uploading from the Logger TripLogik Manager checks the grid reference of each Trip start and end point against those held on the Places database.

If found, the Description held in the Places database will define the start and end of the trip.

If the start or end grid references cannot be found in the Places database the Google Maps™ address will be used to define the respective end.

If the grid reference cannot be identified in Google Maps™ the Description will contain “Unknown”.

*What determines a Trip* – If you are stationary for longer than approx 5 minutes, TripLogik Manager will register the end of your current trip.

**Editing Trips**

Along the top of the Map window are fields carrying information about the Trip and fields you can edit to add further information specific to each trip.

**Merging Trips**

There will be occasions when you will want to merge consecutive trips into one continuous trip. E.g. if you have stopped to refuel it is probable that the logger will assume you have reached your destination.

You can do this in two ways:

Double-Click the last trip in the list of trips you wish to merge to join the selected trip with the Trip above.
Select the first trip you wish to join, hold down the shift key and select the last trip in the list you wish to join. Check Merge from the Edit menu.

Merged trips will appear with ‡ to the left of the item and will report the start and end of the combined trips. The underlying trips can be made visible by clicking on ‡. To hide the underlying trips click on ‡.

You can Demerge trips in a similar manner. With the underlying trips in view, select the trip you wish to demerge and uncheck Merge. The selected trip and any merged trips below will be restored to individual trips.

Deleting Trips
You can remove a trip from the list by choosing Delete from the right hand mouse menu. The item will be removed from the list of visible trips; however, trips will never be deleted from the database but will be placed in the Recycle Bin.

You can restore deleted trips by clicking on the Recycle tab, highlighting the required trip and choosing Restore from the right hand mouse menu.

Categorising Places and Trips
There are two attributes which you can use to qualify places and trips: Category and Qualifier.

Attributes are optional but their use will greatly ease report writing and it is strongly recommended that you make use of them.

When initially installed TripLogik manager has 2 pre-defined categories: Business and Personal. You can change these and/or add new categories.

The Qualifier attribute has no predefined qualifiers it is up to you to add them.

Note – Trips marked with a icon indicates the trip has not been assigned a category.

Modifying Attributes
To add, modify or delete a Category or Qualifier attribute click on the ellipsis button to the left of the appropriate attribute.

Adding a Cost/Charge Rate
The Category attribute has an additional cost per distance unit field. If you enter the cost per distance unit (e.g. £/Mile or €/Km) your trip costs will be calculated and added to your report.

Applying Attributes to Places
When you assign a category or qualifier to a place all Trips from or to that place will assume that attribute as long as the opposite end of the Trip has the same attribute or has no attributes.

Applying Attributes to Trips
If the start and end places of the trip already carry a category and qualifier the Trip may also have these attributes.

If you assign attributes to the Trip these will override any attributes inherited from the start or ends places of that Trip.

Using attributes in Trips can simplify the process of producing filtered reports. (See Producing Filtered Reports for more information).

Saving your Data
To save your data select File, Save. This will save all your Trip and Places information to a database file with the extension '.TLD'.

Typically, once you have saved your first set of Trips and characterised your places you will want to add future Trips to this database.
To add Trips to your existing database, select **File, Open** choose the database and, with your logger connected, click **Sync**. Trips recorded in the logger subsequent to your last Sync will be added to the database.

**About Databases** — The database holds the ID of the logger first used to upload your trips. You can only add future trips to that database from the same logger.

**Working with Reports**

By default, with no filters selected, when you click on the Reports Tab you will see a report listing all the trips you have made with the accumulated mileage from these trips. You can print this report, as is, by selecting **File, Print**.

However, you will inevitably want to change both the layout and to filter the database for a specific set of trips; e.g. your business trips for the month of January.

All customising facilities are accessed via toolbar buttons above the report window.

Assuming you added a category to all your business trips you can report just those trips. To do this you need to apply a Filter.

**Filtering**

While you can filter on places and your trip descriptions, to make best use of the filter functions you need to have assigned a category and optionally a qualifier to your trips. (See Categorising Places and Trips).

Filtering returns only those Trips whose attributes meet the attributes set out in the filter. E.g. If you had categorised some of your trips as business and you set up a filter to filter trips whose category was business the report would only contain business trips.

You can filter on a single attribute for a number of different values. E.g. you might set up the filter Category to contain Personal and Business. This would return all your trips which had been assigned the category Business or Personal but would exclude all other trips.

A text pattern filter is available on the Trip Description attribute. This will return Trips which have the specified words or phrases in their description field and can serve as a useful search function.

You can also filter on the places you set out from, places you travelled to or both.

The filter form is ‘Live’ so any changes you make to the filter will be reflected immediately in the underlying report.

**Remember** — Each filter element is additive; i.e. for a trip to pass through the filter it must meet a criteria value for all of the elements entered.

**Report Layout**

The Layout Report dialog allows you to set a title, headers and footers, page orientation, font style and size. You can also choose whether the report is divided into weekly or monthly sub-totals and whether to add invoicing.

The fields tab allows you to choose which fields you want to show on the report. A default set of fields is provided but you can modify to suit your requirements.

You can see the effect of your layout changes by clicking **Apply**.
Printing a Report
The reports screen shows the report as it would appear printed. To print the report select Print from the File menu.

Saving a Report
You can save a report which can then be opened in other TripLogik Managers. This can be useful if you need to report your travel to your company or wish to share your journeys.

Choose Save from the File menu and save as a TLR file.

**Note** - A saved report only contains those trips which were included in the report and not the underlying data from which the report was built.

Opening a Report
Reports open as view only. You cannot edit a Report but you will have all the standard view facilities available. To open a report, choose Open from the File menu and select a Report file (TLR).

While a report is open the Places and Recycle Tabs will not be available.

**Advanced Features**

Synching with no Internet Connection
TripLogik Manager can only identify locations you have visited if it can access Google Maps at the time you upload your logs.

If you do not have access to the service but still wish to upload your logs you can choose Save Raw... from the File menu.

The saved file can be imported later when access to Google Maps is available by choose Import Raw... from the File menu.

Re-using your Database of Places
After using the logger for some time you will likely have built up a list of places you visit regularly and have personalised them by adding names/descriptions categories and/or qualifiers.

If you want to use this data in a new database select Import Database... from the File menu. This will import all the places information from your old database into your new database.

Exporting to Other Applications
TripLogik Manager can export trips and reports for use in 3rd party applications.

**Trips** – TripLogik Manager can generate a KML file containing the details of a Trip which can be loaded into Google Earth or Google Maps. Select the Trip and choose Export as KML from the Edit menu. (See the online help for more details).

**Reports** – You can save an existing Report as a comma separated value (CSV) file which can later be imported into 3rd party applications such as spread sheets, word processors or databases. With the Report tab selected click on the Export button.

Links
To add photos or additional information to y our trips, you can link a location (either a Place or a start/end point of a trip) to a file or a web address. Right click the location on the Map and click Edit Link... Enter the URL/File name you want to link to and click OK. The location you have linked will carry an additional icon, click on the icon to access the link.

Adjusting your Settings
You can set preferences for a number of features including Distance unit, Map display options and Logger configuration.
See Advanced, Settings in the On-line Help for detail information.

Reference
The following is a quick reference to the TripLogik Manager’s functions. Some of these can also be accessed using Icons on the Toolbar, from the right hand mouse button or using shortcut keys on the keyboard.

File Menu
New
Clears the Manager ready to receive Logger data into a New Database

Open
Opens an existing Database or Report

Save
Saves the current Database or Report

Save As...
Saves the current Database or Report to a new file name

Save Raw...
Saves Logger data as an unprocessed file which can be imported at a later stage

Import Raw
Imports a raw file that had previously been uploaded from the Logger

Import Database
Imports the list of Places from an existing Database

Export Report
Exports a report in a CSV format which other applications such as MS Excel™ can import

Print Setup
Allows you to choose a Printer and select various options depending on the chosen printer

Print
Print will send a Report to the printer

Open on start-up
When checked the current Database will be opened automatically next time you start TripLogik Manager.

Exit
Closes the application

Edit Menu
Merge
Merges the selected Trips with the Trip immediately above

Export as KML
Saves the selected trip in a format which can be displayed in Google Earth™

Delete
Deletes a selected trip from the database

Restore
Restores a select trip from the Recycle bin to the database

Edit Link
Allows you to add a hypertext link to a local file or URL

View Menu
Trip Details
Moves the cursor to the Trip editing panel to allow editing

Full Details
Moves the cursor to the expanded Trip editing panel to allow editing

Recycle Bin
Shows/Hides the Recycle bin

Super Zoom
Shows/Hides the Super Zoom view
**Logger Menu**

**Sync**
Uploads the trips from an attached logger into the current database

**Erase**
Sends a command to the attached logger to clear its trip memory

**Set User Name**
The user name can be up to 16 characters long and will be stored in your logger. You can view the user name from the Logger Status.

**Change Password**...
Enables you to change the password used to access the attached logger

**Logger Status**...
Reports details about the logger's serial number, firmware version, user name and capacity used.

**Settings**
Opens a dialog which enables you to choose your global preferences and configure your TL1000 logger.

**Help**

**Help Topics**
Access the on-line help. You can also access context help by pressing F1 or clicking the help Icon on the tool bar

**Using Help**
On line help on using the help system

**Show Tips**
Opens the Tip of the Day dialog

**What's New**
Opens a help page listing the new features and fixes for the current version of the software.

**TripLogik Web Site**
Opens the TripLogik Web site in your preferred browser

**Check for Updates**
Checks for updates to the TripLogik Application and if available it will prompt you to download and update to the latest version

**About**
Reports the application’s current version number, copyright and license information
### Specification

**GPS Receiver**
- 32 Channels with integral antenna
- Sensitivity up to -165 dB (Tracking)
- Acquisition time (average open sky)
  - Hot Start ~2 Seconds
  - Cold Start ~36 Seconds
- Position Accuracy SBAS 2.5 metres

**Logger**
- Log capacity 1 million records
- All records are encrypted
- Vibration Sensor detects movement
- Power requirements 5V dc at 80mA peak, 50mA average
- Powered from ODBii Connector – recommended or Cigarette lighter adapter
- Visible and Audible indicators report device status
- USB Connection for Power and uploading to PC
- Operating Temperature: -10° min to 70° maximum
- Dimensions 65mm Diameter by 17mm high.

### Acknowledged Trademarks

Microsoft, Windows, Windows XP, Windows Vista and Internet Explorer Scripting are trademarks of Microsoft Corporation.

Google, Google Maps and Google Earth are trademarks of Google Inc.

TripLogik is a trademark of Cougar Innovations Ltd.
1 Year Limited Warranty

**WHO IS COVERED?** Only the original purchaser of the TripLogik TML1000 device

**WHAT IS COVERED?** The TripLogik TML1000 unit and included accessories is warranted to be free from defects in materials and workmanship.

**WHAT IS THE WARRANTY PERIOD?** The warranty begins on the date you purchased the TripLogik TML1000 product and lasts for one year. When the warranty on the original product expires, the warranty on any replacement product also expires.

**WHAT IS EXCLUDED?** Your warranty does not cover:

- Product damage caused by normal wear and tear.
- Product damage caused by tampering, misuse, accident, abuse, neglect, improper installation, misapplication, failure to adhere to the maximum and minimum ratings, alteration of any kind, disaster, or defects due to repairs or modifications made by anyone other than Cougar Innovations Ltd or an authorized service representative of Cougar Innovations Ltd.
- Physical damage of any nature whatsoever to the Product, including any opening or attempted opening of the Product.
- Reception problems due to inappropriate mounting
- Loss of mapping services due to lack of 3rd party services

This Limited Warranty constitutes the final, complete and exclusive statement of warranty terms, and no other person or entity is authorized to make any other warranties or representations on behalf of Cougar Innovations Ltd.

**WHAT IS THE LIMITATION OF LIABILITY?** The Limited Warranty is for the benefit of the original purchaser who first enables the TML1000 product and shall not create or evidence any right in any third party. THE REPAIR OR REPLACEMENT OF THE PRODUCT AS PROVIDED UNDER THIS LIMITED WARRANTY IS THE SOLE AND EXCLUSIVE REMEDY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL COUGAR INNOVATIONS LTD OR ANY RESELLER OR DISTRIBUTOR BE LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL, SPECIAL, INDIRECT, PUNITIVE OR EXEMPLARY DAMAGES OR LOST PROFITS WHATSOEVER ARISING OUT OF THE USE OR INABILITY TO USE THE PRODUCT, OR FOR ANY BREACH OF THIS LIMITED WARRANTY OR OTHERWISE, EVEN IF COUGAR INNOVATIONS LTD HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR SUCH DAMAGES COULD REASONABLY HAVE BEEN FORESEEN BY COUGAR INNOVATIONS LTD.

**WHAT ARE THE WARRANTY LIMITATIONS?** TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, COUGAR INNOVATIONS LTD DISCLAIMS, AND YOU EXPRESSLY WAIVE, ANY AND ALL OTHER WARRANTIES OR REPRESENTATIONS OF ANY KIND OR NATURE, INCLUDING, BUT NOT LIMITED TO, IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE TERM OF ANY IMPLIED WARRANTIES THAT CANNOT BE DISCLAIMED UNDER APPLICABLE LAW SHALL BE LIMITED TO THE DURATION OF THE FOREGOING EXPRESS WARRANTY PERIOD.
Compliance Statements

Europe

European User’s information – Declaration of Conformity

This device has been tested and found to conform with the requirements set out in the Council Directive on the Approximation of Laws of the Member States relating to Electromagnetic Compatibility (89/336/EEC), Low voltage Directive (73/23/EEC) and the Amendment Directive (93/5/EC) and the procedures given in the European Council Directive 99/5/EC and 89/3360EEC.

USA

FCC Compliance Statement

This device has been tested and found to conform with the limits for a class B digital device pursuant to part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation.

Operation is subject to the following 2 conditions:

1. This device may not cause harmful interference
2. This device must accept any interference received, including interference that may cause undesired operation.

FCC RF Exposure requirements

This device must not be co-located or operated in conjunction with any other antenna or transmitter.

NOTE: THE MANUFACTURE IS NOT RESPONSIBLE FOR ANY RADIO OR TV INTERFERENCE CAUSED BY UNAUTHORIZED MODIFICATION TO THIS EQUIPMENT. SUCH MODIFICATIONS COULD VOID THE USER’S AUTHORITY TO OPERATE THE EQUIPMENT.